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Safety Messages

1.0 Safety Messages
 

It is important to follow all instructions shipped with this product. This device is to be 
installed by trained personnel who are thoroughly familiar with the country electric codes 
and will follow these guidelines as well as local codes and ordinances, including any state 
or local noise control ordinances. 

Planning
•	 If suitable warning equipment is not selected, the installation site for the system is 

not selected properly or the system is not installed properly, it may not produce the 
intended optimum audible warning. Follow Federal Emergency Management Agency 
(FEMA) recommendations. 

•	 If the system is not activated in a timely manner when an emergency condition exists, 
it cannot provide the intended audible warning. It is imperative that knowledgeable 
people, who are provided with the necessary information, be available at all times to 
authorize activation. 

•	 The sound output of the system is capable of causing permanent hearing damage. 
To prevent excessive exposure, carefully plan placement, post warnings, and restrict 
access to areas near loudspeakers. Review and comply with any local or state noise 
control ordinances as well as OSHA noise exposure regulations and guidelines.

•	 Activating the system may not result in people taking the desired actions if those 
to be warned are not properly trained about the meaning of warning sounds. Users 
should follow FEMA recommendations and instruct those to be warned of correct 
actions to be taken.

After installation, service, or maintenance, test the system to confirm that it is operating 
properly. Test the system regularly to confirm that it will be operational in an emergency. 

1.1 Safety Messages to Installers
People’s lives depend on your safe installation of our products. It is important to follow 
all instructions shipped with this product. This device is to be installed by a trained 
electrician who is thoroughly familiar with the National Electrical Code and/or Canadian 
Electrical Code and will follow the NEC and/or CEC Guidelines as well as all local 
codes. 

The selection of the mounting location for this system, its controls and the routing of 
the wiring are to be accomplished under the direction of the Facilities Engineer and the 
Safety Engineer. In addition, listed below are some other important safety instructions 
and precautions you should follow:

•	 Electrocution or severe personal injury can occur when performing various 
installation and service functions such as making electrical connections, drilling 
holes, or lifting equipment. Therefore, only experienced electricians should install 
this product in accordance with national, state and any other electrical codes having 
jurisdiction. Perform all work under the direction of the installation or service crew 
safety foreman.
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•	 Read and understand all instructions before installing, operating, or servicing this 
equipment.

•	 All effective warning sounds may, in certain circumstances, cause permanent hearing 
loss. Take appropriate precautions such as wearing hearing protection. Maximum 
sound level exposure limits specified in OSHA 29 CFR 1910 should not be exceeded.

•	 For optimum sound distribution do not install the loudspeakers where objects would 
block any portion of the front of the system.

•	 Establish a procedure to routinely check the signal system for proper activation and 
operation.

•	 Any maintenance to the unit MUST be performed by a trained electrician in 
accordance with NEC Guidelines and local codes or a Federal Signal certified 
Service Provider.

•	 Never alter the unit in any manner.

•	 The nameplate should NOT be obscured, as it contains cautionary and/or other 
information of importance to maintenance personnel.

•	 After installation and completion of initial system test, provide a copy of these 
instructions to all personnel responsible for operation, periodic testing, and 
maintenance of the equipment.

•	 File these instructions in a safe place and refer to them when maintaining and/or 
reinstalling the device.

Failure to follow all safety precautions and instructions may result in property damage, 
serious injury, or death.

Installation and Service
•	 After installation or service, test the system to confirm that it is operating properly. 

Test the system regularly to confirm that it will be operational in an emergency.

•	 If future service and operating personnel do not have these instructions to refer to, 
the system may not provide the intended audible warning and service personnel 
may be exposed to death, permanent hearing loss, or other bodily injury. File these 
instructions in a safe place and refer to them periodically. Give a copy of these 
instructions to new recruits and trainees. Also give a copy to anyone who is going to 
service or repair the system.

•	 To reduce the risk of electric shock, do not perform any servicing other than what 
is contained in the operating instructions unless you are qualified to do so. Refer all 
servicing to qualified service personnel. Always test the system before using after 
repairs have been made. 
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Ethernet Wiring
•	 Unless shielded or run in conduit, Ethernet wiring must be at least six feet from bare 

power wiring or lightning rods and associated wires, and at least six inches from 
other wire (for example, antenna wires, doorbell wires, wires from transformers to 
neon signs), steam or hot water pipes, and heating ducts.

•	 Do not place Ethernet wiring or connections in any conduit, outlet or junction box 
containing high voltage electrical wiring.

Symbol Definition

_A    _V 	 Indicates to reduce the risk of fire, replace fuse as marked.

Pay careful attention to the notice located on the equipment.

Read and understand the information contained in this manual before 
attempting to install or service the system.
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General Description

2.0 General Description
2.1 Introduction

This document is a description, installation, and user manual for the PAGASYS GEN II 
System Manager application software. The System Manager software is a user interface 
to the PAGASYS GEN II Controller. Its intended audience are those assigned to use and 
maintain the system.

2.2 Overview
The PAGASYS GEN II system includes:

•	 System Controller—Located in the Controller Chassis of the Cabinet

•	 System Manager software—Interfaces with the System Controller

Use the System Manager software to do the following: 

•	 Monitor the status of the system 

•	 Broadcast messages

•	 Create the control panel 

•	 Configure equipment, zones, and audio

•	 Conduct field diagnostics

The System Manager software and the PAGASYS GEN II Controller use a configuration 
file to ensure configuration data is consistent between the System Manager software and 
the Controller. The definitive source for this configuration file is the PAGASYS GEN II 
Controller. The System Manager application retrieves the configuration data from the 
PAGASYS GEN II Controller when the application is started and maintains the local 
configuration in memory. To ensure that the Controller recognizes the changes uploaded 
to the system, manually restart the Controller (FILE > RESTART CONTROLLER 
from the application menu) when appropriate. After the Controller returns, changes are 
populated to all System Manager processes connected to the Controller.

A configuration file automatically updates the PAGASYS GEN II application by 
retrieving the configuration data from the Controller when the application is started. 
The changes are made to all System Manager processes connected to the Controller. To 
restart the controller from the System Manager software’s Home Page: FILE > RESTART 
CONTROLLER

While the primary operator interface to the PAGASYS GEN II system is the System 
Manager software, the PAGASYS GEN II system continues to operate normally if the 
connection to the System Manager software is lost.
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General Description

Figure 1 System Architecture
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General Description

2.3 Operating Requirements
The PAGASYS GEN II System Manager operates in a Windows-based server 
environment.

2.3.1 Prerequisites
1.	 Ensure Hardware meets minimum standards (See Hardware Requirements.)

2.	 Windows OS

•	 Windows 10 Professional

•	 Windows Server 2008 R2

•	 Windows Server 2012 R2

•	 Windows Server 2016

3.	 Microsoft .Net IIS v.7.5 or higher

4.	 .Net Framework v.3.5 or higher

2.3.2 Hardware Requirements
Recommended configuration for one machine
•	 Processor: Intel Core i7 8 CPU core

•	 Memory: 8 GB

•	 HDD: 144 GB SSD

•	 Operating system: Windows Server 2012(R2) x64, or Windows 10 Pro x64

•	 Web server: IIS7.5

•	 SQL server: Microsoft SQL Server 2014 x64

Recommended configuration for multiple servers
•	 Processor: Intel Xeon 2GHz 4 CPU core

•	 Memory: 8 GB

•	 HDD: 144 GB SSD

•	 Operating system: Windows Server 2012(R2) x64, or Windows 10 Pro x64

•	 Web server: IIS7.5

•	 SQL server: Microsoft SQL Server 2014 x64
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Installing the System Manager Software

3.0 Installing the System Manager Software
Install the PAGASYS GEN II System Manager on a target computer that has a network 
(Ethernet) connection to the PAGASYS GEN II Controller. 

3.1 Installing and Configuring the System Manager Software
The automated installer program does the following:

•	 Installs, upgrades, and configures the System Manager software.

•	 Creates the database, tables, and populates the necessary configuration table entries.

•	 Configures the correct settings in Internet Information Services (ISS).

NOTE: A manual installation procedure is available, but not recommended for the typical 
user.

The System Manager software is distributed on the USB drive.

To install the System Manager software (P-SYSMGR-G) on your computer, do the 
following:

1.	 Insert the System Manager USB drive into a USB port on the target computer.

2.	 Move the installation MSI file to the desktop for the target computer. 

3.	 Double-click the MSI file to launch the automatic installation program. 

	 NOTE: The installation program prompts you for information at various stages of 
the process. If you are not familiar with Windows setup procedures, enter the default 
option for all prompts. On completion, the System Manager software is installed and 
a shortcut icon appears on the Windows Startup Group and All Programs Menu. 

The following is the opening image for System Manager.
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Installing the System Manager Software

The InstallAware Wizard dialog appears.

The following dialog box appears listing the required Windows features that need to be 
installed prior to running the System Manager installer.

The following are the dialog boxes that appear when you go though the installation 
program.

4.	 Wait for the files to be extracted.

The following dialog appears.
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5.	 Read the information, and then click Next to continue.

The following dialog appears.

6.	 Select the I accept the license agreement check box, and then click the Next button.

The following dialog appears.

7.	 Click the Next button.
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Installing the System Manager Software

The following dialog box appears.

8.	 Enter the User Name and User Company, and then click the Next button.

The following dialog box appears.

9.	 Click the type of setup you would like to perform (typically, Complete Setup), and 
then click the Next button.
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The following dialog box appears.

10.	 Select the destination folder for the application, and then click the Next button.

The following dialog box appears.

11.	 Click All Users to create a shortcut for all users, and then click the Next button.
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Installing the System Manager Software

The following dialog box appears.

12.	 Click the Next button to install the System Manager software. Click Back to review 
your installation settings.

13.	 The following dialog box appears while the product is installing; you see a progress 
bar that indicates the status of the installation.
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14.	 The following dialog box appears when the installation is complete.

15.	 Click the Finish button.

3.1.1 License Activation
16.	 After installation, contact Federal Signal Customer Support to obtain your license 

key. See Getting Service.

The Licensing dialog box appears.
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Installing the System Manager Software

17.	 Click Activate Online if you have access to the Internet. The following dialog box 
appears.

18.	 Type your activation key.

19.	 Click the Activate license key button. The following dialog box appears.

Activation Without Internet Access
	 Activation can be completed without access to the Internet. Click Activate Offline if 

you do not have access to the Internet. The following dialog box appears. 
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	 Click Scan QR Code. The following dialog box appears.

	

	 Using your smartphone and any QR Code Scanning application, scan the QR code on 
the dialog box. Before scanning, make sure your mouse cursor does not overlap with 
the QR code.

	 After you scan the QR code, a Computer Key will display on your smartphone.

	 Close this dialog box and enter the key displayed on your phone in the Computer 
Key field of the Activation Offline dialog box.

20.	 Type your activation key.

21.	 Click the Activate license key button. The following dialog box appears.

22.	 Click OK.  



22    
PAGASYS GEN II (P-SYSMGR-G) 

Federal Signal www.fedsig.com

Starting the System Manager Software

4.0 Starting the System Manager Software
Begin a System Manager session either locally on the computer the system was installed 
or remotely. 

4.1 Connecting Remotely
To begin a System Manager session remotely, connect to the IP address and port of the 
System Manager server and application. The System Manager default configuration will 
have the default IP address of the System Controller.

NOTE: Multiple System Manager sessions can connect to a PAGASYS GEN II 
Controller concurrently and changes made by one of the sessions are shared with the 
other sessions.

To begin a session remotely:

1.	 Open a browser on your PC to access a running System Manager application.

2.	 Enter the IP address and port of the server that is running the System Manager 
application. The following is an example.

10.36.169.58:8091

where:

10.36.169.58 is the IP address

8091 is the IP port for the application

3.	 Enter User Name

admin (default administrator username)

4.	 Enter Password.

admin (default administrator password)
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System Manager Software Main Window

The Home Page appears.

5.0 System Manager Software Main Window
The following picture describes the main components of the System Manager Software 
window: Menu icon, Menu Panel, Application Menu, and Information Bar.

5.1 Viewing the Menu
The Menu icon opens and closed the menu on the left side of the window.

5.2 Menu Panel
The menu is located on the left side of the window and has the following choices: Status, 
Control Panel, Configuration, or Field Diagnostics.

5.3 Application Menu
The Application Menu has the following choices: File, View, Report, Theme, and Users.

NOTE: The View menu is only available when a Globalization license is entered for the 
system.

Menu 
Panel

Application Menu

Information Bar

Menu 
icon
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System Manager Software Main Window

5.4 Information Bar
The Information Bar is located at the bottom of the System Manager window and is 
present on all windows. The Information Bar displays the information related to local 
rack name, current broadcast status, communication status, logged-in user details and the 
version of the application software. 

5.5 Sorting the Columns
The System Manager Software displays columns of information. You are able to sort 
these columns.

To sort a column:

1.	 Select the column you want to sort.

2.	 Click the column header to choose between either ascending or descending order.

5.6 Grouping Lists within the System Manager Software
The System Manager software offers list grouping. 

To list by groups:

1.	 Select the column header you want to group.

2.	 Drag column header to the words (drag a column header and drop it here to group 
by that column) at the top right of the window.

3.	 Click the X to close the box. 

5.7 Using Text Filters
You are able to use text filters within the System Manager windows. 

To use text filters:

1.	 Select the filter system icon . 

	 One of the following dialog box appears.

        

	 Select from the following: Is equal to, Is not equal to, Starts with, Contains, Does 
not contain, Ends with, Is null, Is not null, Is empty, or Is not empty.
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System Manager Software Main Window

You can filter on one column, or two fields using an Or or And filter.

When available, select the calendar icon to select a date.

When available, select the down or up arrow to select a number.

2.	 The data is filtered by the selected text filter.
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File Menu

6.0 File Menu
The File Menu is responsible for the following: downloading the configuration from 
the controller, uploading the configuration to the controller, sync audio to the controller, 
export configuration to file, import configuration from file, exit, and restart the 
controller.

6.1 File Menu > Download Config from Controller
To download the configuration from the controller to either a file or database: click File 
Menu > Download Config from Controller.

6.2 File Menu > Download Net Config from Controller
To download the network configuration from the controller to either a file or the database: 
click File Menu > Download Net Config from Controller.

6.3 File Menu > Upload Config to Controller
To upload the configuration to the controller to either local, remote, or both: click File 
Menu > Upload Config to Controller.

6.4 File Menu > Sync Audio to Controller
To sync audio to the controller: click File Menu > Sync Audio to Controller.

6.5 File Menu > Export
To export configuration to file with or without audio or export log to text file: click File 
Menu > Export.

6.6 File Menu > Export Net Config
To export the network configuration to a file: click File Menu > Export Net Config.

6.7 File Menu > Import
To import configuration from file with or without audio: click File Menu > Import.

6.8 File Menu > Exit
To exit: click File Menu > Exit.



27
SYSTEM MANAGER Description, Installation, and User Manual 
Federal Signal www.fedsig.com

File Menu

6.9 File Menu > Restart Controller
To restart the controller either local or remote: click File Menu > Restart Controller.
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7.0 View Menu
The View Menu is responsible for changing the text in the System Manager software 
window to another language.

NOTE: Only application text is converted to the target language. Any text entered by the 
user is displayed in the language in which it is entered.

The View menu is only available when a license key is purchased to activate a 
Globalization feature (multi-language support).

7.1 View Menu > Select Language
To change the text in the System Manager software window to another language: Click 
View Menu > Select Language > select a language.

NOTE: The View menu is only available when a Globalization license is entered for the 
system.
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8.0 Report Menu
The Report Menu is responsible for exporting the event log and displaying 
manufacturing details.

8.1 Report Menu > Event Log
To export the event log: click Report Menu > Event Log.

A report is generated similar to the one below.
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8.2 Report Menu > Manufacturing Details
To display manufacturing details: click Report > Manufacturing Details. The 
Manufacturing details window appears.

Fields Description
Card Type Displays the card type.
Page Displays the page.
Serial Number Displays the serial number.
Part Number Displays the part number.
Board Build Date Displays the date the board was build.
Firmware Version Displays the version of firmware.
Firmware Commit Displays the firmware commit. 
Refresh Click the Refresh button to refresh the information.
Export to PDF Click the Export to PDF button to export the window to a PDF.
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9.0 Users Menu
The User Administration component is responsible for displaying user attributes and 
provides the functionality for creating, editing, and deleting the users (depending on the 
role of the logged-in user). 

The Users Menu provides the following options: Administrative Settings, Licensing, 
Select Organization, User Profile, and Log Out.

NOTE: The View menu is only available when a Globalization license is entered for the 
system.

9.1 Users > Administrative Settings
To access the Administrative Settings, select Users > Administrative Settings. The 
Administrative Setting has the following tabs: Users, User Roles, Features, Role 
Mapping, and Application Setting.

9.1.1 User Administration > Users
The following is the User Administration window.

Fields Description
Add User Select button to add a new user.
User Name User-provided user name. 
Full Name Full name of user.
Password Does user need a password for login.
Enable User allowed to access the system.
Delete icon Removes selected user.
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9.1.2 Adding Users
To add users:

1.	 Click Add User button. The Add New User dialog box appears.

Fields Description
Add New User
Full Name User-provided full name of user.
User Name User-provided system user name.
Password User-provided password for new user. (Can select using Admin 

password.) No password allows login without password.
Roles Select new user roles. (Can be created under User Roles.)
Organizations User-provided Organization.
Is Active Select check box to make new user active on system.
Save Select to save new user.
Cancel Select to cancel creation of new user.
User Name Displays current list of user names.
Full Name Displays current list of full user names.
Password Displays whether the user has created a password with user 

account.
Enabled Displays a check mark if user is active on system.
Delete icon Deletes selected user account.

3.	 Enter the fields.

4.	 Click Add.
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9.1.3 User Administration > User Roles
Assign User Roles to users to define the feature the user will have access to use in the 
System Manager.

Fields Description
+ Add new record Select to display the Add Role dialog box to add new record.
Role Name User-provided role name.
Enabled Displays a check mark if user role is active on the system.
Edit icon Displays the Edit Role dialog box to edit selected role.

Delete icon Deletes selected role.

Adding a new Role
To add a new role:

1.	 Click the Add Role button. The Add Role dialog box appears.

Fields Description
RoleName User-provided role name.
IsActive Select check box to make the new role active on system.
Update Saves the new role.
Cancel Cancels the creation of the new role.

3.	 Enter the fields.

4.	 Click Update.
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Editing a Role
To edit a role:

1.	 Click the Edit icon. The Edit Role dialog box appears.

Fields Description
RoleName Type a role name.
IsActive Select check box to make the new role active on system.
Update Saves the role.
Cancel Cancels the change.

3.	 Enter the fields.

4.	 Click Update.

9.1.4 User Administration > Features
The Features tab displays the different features available on the system that you can 
assign to User Roles. You cannot add new features, but you can edit existing ones. 
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Editing a Feature
The term Parent relates to the System Manager’s component associated with the feature. 
For example, the Restart Controller feature is an attribute of the FILE menu (that is, FILE 
> RESTART CONTROLLER)

To edit a feature:

1.	 Click the Edit button. The Edit Feature dialog box appears.

Fields Description
FeatureCaption User-provided name of Feature.
Parent Caption User-provided component associated with the feature.
ParentName Component associated with the feature.
IsActive Select check box to make the feature active on system.
Update Saves the feature.
Cancel Cancels creation of the feature.

3.	 Enter the fields.

4.	 Click Update.
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9.1.5 User Administration > Role Mapping
This window allows assignment of different features to the existing roles.

Fields Description
User role User Roles available on the User Roles window.
Feature A list of available features for each User Role.
Parent System Manager Component that uses selected feature.
Is Active If set, indicates that the selected feature is active.
Access Select check box to enable the feature for the selected user.

9.1.6 User Administration > Application Setting
This window allows you to edit the values described in the Key field.

Fields Description
Key User-described applications.
Value Displays the value of the key.
Edit icon Allows you to edit the Value field.
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NOTE: If you change any of Application Setting, all sessions are logged out and the 
application will restart.

9.2 Users > Licensing
To access the Licensing Wizard, select Users > Licensing. The Licensing Wizard dialog 
box appears.

Fields Description
Activation Key Displays optional activation key for the System Manager. 

Contact your Federal Signal sales representative to acquire an 
activation key for optional features, such as Globalization (multi-
language support.

Days Left Displays the number of days left for the license.
Maintenance plan 
expires on

The date the maintenance play expires.

Features Displays features.
License 
Registration 
Wizard

Opens a dialog box to either Activate you license or Deactivate 
your license.
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9.3 Users > Select Organization
To access the Organization settings, select Users > Select Organization. The Organization 
window appears.

Fields Description
Add Organization Displays the Add New Organization window.
Name Displays the name of the record.
Phone Displays the phone number of the record.
Email Displays the email of the record.
Enabled Displays a check mark if user is active on system.
Service Name Displays the service name.
Delete icon Deletes the selected record.

9.3.1 Adding Organizations
To add a organization:

1.	 Click the Add Organization button. The Add New Organization window appears.
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Fields Description
Organization 
Name

Type the organization's name.

Phone Type the organization's phone number.
Email Type the organization's email.
Company Size Type the organization's company size.
Notes Type your notes.
Service Name Type of service name.
Is Active Select check box to make new organization active on system.
Save Click the Save button to ensure changes are saved to the System 

Manager.
Cancel Cancels the creation of a new organization.

3.	 Enter the fields.

4.	 Click Save.

9.4 Users > User Profile
To access the User Profile settings, select Users > User Profile. The User Profile window 
appears.

Fields Description
Full Name Displays the user’s full name.
User Name Displays the user’s name.
Role Displays the user’s role.
Organization Displays the user’s organization.
Update Profile Click the Update Profile button to update the profile. 
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Fields Description
Old Password Type the old password.
New Password Type the new password.
Confirm 
Password

Type the new password again.

Cancel Cancels the changes.

9.5 Users > Log Out
To Log out of the software, select Users > Log Out. 
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10.0 Using Status
The Status component is responsible for displaying current system activity and the event 
log details. The Status window displays System Activity, Broadcasts, Event Logs sent by 
the system. 

To access the Status window, click the Status menu item. The Status window appears. 
Use the Menu icon to open and close the Menu Panel.

10.1 Status > System Activity
To activate the System Activity window, click System Activity.

The Status System Activity window provides a list of active system faults, including the 
type of fault, device type with the fault, and device ID/name.

Status
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10.2 Status > Broadcasts
The Status Broadcasts window displays active broadcasts on the system, by zone 
and priority. The system may have up to six different broadcasts active concurrently. 
Broadcasts are listed in columns on this page, with the highest priority in the leftmost 
column and decreasing in priority moving right. Silent broadcasts will be displayed in 
the rightmost column. Zones with active broadcasts are listed in rows on this page. The 
system can have a total of 128 zones, with broadcasts active across one or more zones. 
Zones can have multiple broadcasts with different priorities. You can only have one 
broadcast active in a zone, so the highest priority broadcast in a zone will be active. 
Broadcasts that are superseded by a higher priority broadcast activate when a higher 
priority broadcast completes. The one exception to the single broadcast active at one time 
is when a duckable alarm is active and an Emergency Page is requested. In this case, 
the duckable alarm is reduced in volume while the Emergency Page is active, and then 
returns to normal volume after the completion of the Emergency Page.

Intersecting points on this window where a Broadcast is active in a Zone have a color 
matching the type of broadcast.

Broadcast Type Color
Emergency Page Light Blue
Alarm Red
Priority Page Amber
Routine Page Green
Routine Message Green
Program Audio Grey

The current highest priority Broadcast displays in the Broadcast field on the Information 
Bar. Double-click on the Broadcast text (located on the Information bar) from any System 
Manager window to return to the Broadcasts window.

To access the Broadcasts window, click Broadcasts.
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10.3 Status > Event Log
Event logs include Faults and activity from system devices. Events include date/
timestamp for the event, the Controller reporting the event, Status Type, Device Type, 
Device ID/Sub ID, Name, and whether the event was raised or cleared at the event time. 
Events can be duplicated if more than one Controller is active. Order or filter events in 
the log by any available column.

To activate the Event Log window, click Event Log.

10.3.1 Exporting the Event Log
To export the Event Log: click the REPORT > EVENT LOG menu item.
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11.0 Using Control Panel
The Control Panel component displays the access panel buttons and the interface to 
communicate with the controller for the access panel button selections. 

The Control Panel provides you with a software configurable control interface that can 
enable broadcast initiation and system status indications. The Control Panel is fully 
configurable using the Control Panel Designer under the Configuration section. You can 
maintain multiple versions of Control Panels in the system, with easy transition between 
different views using the Control Panel selectable items or buttons.

To access the Control Panel window, click Control Panel. Use the Menu icon to open and 
close the Menu Panel.

The Control Panel window appears.

Control 
Panel
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12.0 Using Configuration
The Configuration component is responsible for displaying the configuration available on 
the controller and also provides the functionality to modify the configuration that is sent 
to the controller. 

To access the Configuration window, click Configuration. Use the Menu icon to open and 
close the Menu Panel.

12.1 Configuration > General
The General Configuration window allows the user to configure the PAGASYS GEN II 
system attributes.

To activate the General window, click the General tab.

Fields Description
System Type Controller redundancy needed by user. Options are Single, High 

Integrity (Master + Standby), or Duplicated Pair.
Is Networked Click the check box to indicate networked. Select from available Rack 

Id.
Name User-defined text system Name.
Project Number User-defined text Project Number.

Configuration
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Fields Description
Comments Comments related to the general system. The maximum length is 512 

characters.
Cabin Monitoring 
Times

Four-column table that allows you to define Hour and Minute for 
monitoring of speakers if you do not want monitoring to occur 
24 hours a day. Duration (in minutes) to monitor, and a check box to 
Enable monitoring. Limited to 6 time periods. Group Monitoring Times 
by any column (Hour, Minute, Duration or Enable) by moving the 
desired grouping field column header into the grouping area at the top 
of the Cabin Monitoring Times window. (Drag a column header and 
drop it here to group by that column.)

ISMT
Comms Retries On the ISMT window, number of communication retries to perform 

with the ISMT card. 
Allow Parallel 
Testing

On the ISMT window, click the check box to allow testing of all ISMT 
cards in the system concurrently, or uncheck to allow ISMT cards to 
test sequentially. 

Alarms
Alarm attenuation 
by

On the Alarms window, set a value to attenuate alarms to enable 
effective verbal communication. The range is 0 dB to 60 dB in steps of 
1.

DB for On the Alarms window, enter a time period for Alarm Attenuation. The 
range is 1 to 1800 seconds in steps of 1.

Alarm Mute 
Duration

On the Alarms window, the amount of time to mute the alarm. The 
range is 1 to 1800 seconds in steps of 1.

Other Settings
Amplifier Test 
every minute

On the Other Settings window, the time between Amplifier tests. The 
range is 1 min to 120 minutes in steps of 1. 

Impedence Test 
Every minute

On the Other Settings window, the time between Impedence tests. 
The range is 1 min to 120 minutes in steps of 1. 

Event Log 
Retention Days

On the Other Settings window, the amount of time to retain Event 
Logs in system. The range is 1 day to 366 days in steps of 1. 

Amplifier Crosstalk 
Threshold Volts

On the Other Settings window, the amount of volts of the amplifier 
crosstalk. The range is 1 to 5 in steps of 1. Threshold Volts.

AB Link Comm 
Timeout

On the Other Settings window, the timeout period for the 
communications link between the A/B systems.

Is Amp Test After 
Broadcast

Click this check box for an Is Amp test after broadcast.

Impedance Test 
After Broadcast

Click this check box for an Impedance test after broadcast.
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12.2 Configuration > Equipment
The Equipment configuration window allows you to create new equipment entries on 
this window by selecting the type of item needed, and then selecting the Add button. 
To remove an existing item from the equipment configuration screen, select the item to 
delete and select the Remove Selected Node button.

To access the Equipment window, click the Equipment tab.

Fields Description
Add Add a new equipment item under the equipment menu. Create the 

following: Amplifier, Amplifier Group, Access Panel, Access Panel 
Button, Access Panel Indicator, AP Mux Card, Beacon Monitoring 
Card, Beacon Monitoring Card Channel, Controller, Fan Monitor Card, 
Monitored Input Card, Monitored Input Card Channel, Input Card, Input 
Card Channel, ISMT Card, ISMT Speaker, Output Card, Output Card 
Channel, Misc (PABX) Card, Virtual Input Card, Virtual Input Card 
Channel, Virtual Output Card, Virtual Output Card Channel.

Remove Selected 
Node

Delete an existing equipment item.
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12.2.1 Configuration > Equipment > Controller
Select the Controller configuration window from the Equipment Configuration window 
by selecting the Controllers item. Select a specific controller to configure from the 
Equipment menu.

Fields Description
Controller ID Static field indicating the ID number for the selected controller. This 

field cannot be changed.
Name User-defined Name for the controller.
Serial Number Serial Number of the controller.
Scope Select either A Master or B Standby.
Load from 
Controller

Click to load controller serial number from the controller in the rack.

Network Configuration
IP Address User-defined IP Address for the controller.
Net Mask IP Subnet Mask for the controller.
Default Gateway Network Default Gateway for the controller.
IP Version IP Version used on the PAGASYS GEN II system. Select either version 

IPv4 or IPv6.
Comments User comments related to this controller.
Save Click the Save button to ensure changes are saved to the System 

Manager.
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12.2.2 Configuration > Equipment > Amplifier Group
Select the Amplifier Group configuration window from the Equipment Configuration 
window by selecting the available Amplifier Group. 

Fields Description
Group ID Numerical Amplifier Group ID (1-32). Amplifier Group IDs must be unique 

within a system.
Name User-defined Name for the Amplifier Group.
Comments Comments related to the specific amplifier Group selected. Common 

comments include whether ISMT or a Standby Amplifier is included on the 
Amplifier Group.

12.2.3 Configuration > Equipment > Amplifier
Select the Amplifier configuration window from the Equipment Configuration window 
by selecting the available amplifier. Wire the amplifiers that are in the same group to the 
same Standby Bus.

Fields Description
Name User-defined Name for the Amplifier
Amplifier ID Numerical Amplifier ID (1-128). Amplifier IDs must be unique within a 

system.
Scope Select from A Master, B Standby, Duplicated, or Shared.
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Fields Description
Comments Comments related to the specific amplifier selected. 

Comments are useful for recording which speaker loops are attached 
to this Amplifier (for example, Accounts Office and Conference room 1).

Options
Monitoring One of the Amplifier options. This field allows you to select the type of 

monitoring needed for this Amplifier. Options include None, ISMT Spur 
Monitoring, ISMP Loop Monitoring, or Impedance Monitoring.

Zone Standby Defines the Zone for the Amplifier. The only standard zone is Standby 
(no zone): all other zones are user created from the Configuration > 
Zones menu.

Testing is 
Restricted to 
Cabin Monitoring 
Times only

Click this check box if amplifier testing should be restricted only to 
Cabin Monitoring Time.

Comms Timeout 
(Secs)

Set number of seconds until communication times out. Range 1.0 to 
26.5 seconds in 0.1 second steps.

Is Parallel 
Banked

Click this check box to indicate that this amplifier is parallel banked to 
its buddy amplifier. Parallel banking allows audio output values two 
times standard audio output. Parallel banking also requires parallel 
wiring on the audio distribution card.

Output Voltage 
RMS

Click to select desired output voltage. Select either 100 V or 70 V. 

Fallback Channel Set channel to use for fallback on the Amplifier.
Local Properties
Add new record Opens the New Local Properties dialog box that allows you to 

configure amplifier parameters. Include values for Scope, Broadcast 
Gain, Impedance Lower Limit, Impedance Upper Limit, and Pilot Tone 
Threshold.

Save Click the Save button to ensure changes are saved to the System 
Manager.
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12.2.4 Configuration > Equipment > Beacon Monitoring Card
The Beacon Monitoring Card dialog box is selected from the Equipment Configuration 
window by selecting one of the Beacon Monitoring Cards. 

To view the Beacon Monitoring Card dialog box, click an item under Beacon Monitoring 
Cards from the list. 

Fields Description
Output Card ID Numerical Card ID. The range is 1-255.
Name User-defined name for the Output Card.
Comments Comments related to the specific Input Output selected. 
Scope Select either A Master, B Standby, Duplicated, or Shared.
Serial Communications
Bus ID Select the Bus ID for the Input Card. Determines which I/O socket the 

board is connected to. The range is 1-4.
Node ID Select the Node ID for the Input Card. This must match the DIP switch 

setting on the card. The range is 1-63.
Timeout Period 
(Secs)

Set number of seconds until communication times out. The range is 
1.0 to 26.5 seconds in 0.1 second steps.
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12.2.5 Configuration > Equipment > Beacon Monitoring Card Channel
After creating a Beacon Monitoring Card from the Equipment Configuration window, 
configure the specific Beacon Monitoring Card channels by selecting the card listed 
under the Beacon Monitoring Cards list and adding an Beacon Monitoring Card 
Channel. 

Fields Description
Output Chan ID Numerical Beacon Monitoring Card Channel ID. The range is 1-255.
Name User-defined Name for the Beacon Monitoring Card Channel. The 

maximum length is 64 characters.
Comments Comments related to the specific Beacon Monitoring Card Channel 

selected. The maximum length is 500 characters.
Scope Select either A Master, B Standby, Duplicated, or Shared.
Settings
Sense Sense for the Beacon Monitoring Card Channel defines the behavior 

of the system when the input signal is detected. Sense can be 
Normally Open/NDE or Normally Closed/NE.

Active On Failure Select the Active On Failure for the Monitoring Card. Active On Failure 
can be Active, Inactive, or Stay Same.

Active On Power-
Up/Reset

Check box that indicates whether the Beacon Monitoring Card 
channel should be active when powered up or reset.

Recovery Time 
(Secs) after 
activation

Set number of seconds of recovery time after activation. The range is 
1.0 to 26.5 seconds in 0.1 second steps.

Visibility
Show State in 
Event Log

Visibility field that enables state reporting in the System Event Log.

Show State in 
System Activity

Visibility field that enables state reporting in the System Activity 
window.
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Fields Description
Local Properties
Add new record Displays the New Local Properties dialog box to add new properties 

record. Typically, one record is needed for each scope type of the 
system (A Master, B Standby, etc).

Output Function
Function Function can be output_channel_bcast_active_all, output_channel_

bcast_active_any, output_channel_bcast_slice_detect, or output_
channel_simple. Beacon Monitoring Card parameters and connections 
are displayed below the Function box, when available.

Parameters
Broadcast List Select from available broadcasts which broadcasts to enable.
Zone List Select from available zones which zones to apply the selected 

function.
Connections-Inputs
Add Connection Opens the Widget Input Details dialog box that allows you to add an 

input widget connection for the channel.
Inhibit Inhibits the input.
Drive Drives the input.
Connections-Outputs
Add Connection Opens the Widget Input Details dialog box that allows you to add an 

output widget connection for the channel.
State The logical state of the output.
Raw State The physical state of the output before any inhibit has been applied.
All Zones Active Output is active when all zones are playing specified broadcast.
Any Zone Active Output is active when any zone is playing specified broadcast.
Save Click the Save button to ensure changes are saved to the System 

Manager.
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12.2.6 Configuration > Equipment > Input/Output Card
All of the Input/Output Cards have common configuration fields that you can modify 
from the specific Input or Output Card items in the Equipment list. The Input cards 
include the Input Card, Monitored Input Card, and Virtual Inputs. The Output cards 
include the Relay Output Card, Beacon Monitoring Card, and Virtual Output Card.

Each card has additional fields that you can configure by clicking the channel under the 
Input or Output Card Equipment list. These lower-level configured items are discussed 
later.

Fields Description
Input Card ID Numerical Card ID. The range is 1-255.
Name User-defined name for the Input Card.
Comments Comments related to the specific Input Card selected. 
Scope Select either A Master, B Standby, Duplicated, or Shared.
Serial Communications
Bus ID Select the Bus ID for the Input Card. Determines which I/O socket the 

board is connected to. The range is 1-4.
Node ID Select the Node ID for the Input Card. This must match the DIP switch 

setting on the card. The range is 1-63.
Timeout Period 
(secs)

Set number of seconds until communication times out. The range is 1.0 
to 26.5 seconds in 0.1 second steps.

Save Click the Save button to ensure changes are saved to the System 
Manager.
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12.2.7 Configuration > Equipment > Input Card Channel
All of the Input Cards Channels have common configuration fields that you can modify 
from the specific Input Card items in the Equipment list. The Input Cards Channels 
include the Input Card Channel, Monitored Input Card Channel, and Virtual Input Card 
Channel.

After creating an Input Card from the Equipment Configuration window, configure the 
specific Input Card channels by selecting the card listed under the Input Card list and 
adding an Input Card Channel. 

Fields Description
Card ID Numerical Input Card ID. The range is 1-255.
Name User-defined Name for the Input Card Channel. The maximum length is 

64 characters.
Comments Comments related to the specific Input Card Channel selected. The 

maximum length is 500 characters.
Scope Select either A Master, B Standby, Duplicated, or Shared.
Settings
Sense Sense for the Input Card Channel defines the behavior of the system 

when the input signal is detected. Sense can be Normally Open/NDE 
or Normally Closed/NE.

Mode Defines the action supported by the system when the button is 
selected. Options are Direct, Toggled, or Latched. Holdoff Time and 
Minimum Active Time are only visible for Direct Mode. Holdoff time is 
also visible for toggled mode.

Contact Type Contact Type can be Dry/Volt Free Contact or Wet/Energized Contact. 
Use this field with isolated Input Cards. It is not visible on the Monitored 
Input Card or Virtual Input Card configuration.

Holdoff Time 
(Seconds)

Defines the amount of time that must pass before the input can be 
triggered after being cleared. The value can be set between 0 and 
1 hour in 1 second increments.

Minimum Active 
Time (Seconds)

Minimum Active Time indicates the Minimum Time an action remains 
active after being initiated. Minimum Active Time is only visible when 
Mode is Direct Mode. The range is 0 to 1 hour in 1 second intervals.
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Fields Description
Maximum Active 
Time (Seconds)

Maximum Active Time indicates the Maximum Time an action remains 
active after being initiated. The range is 0 to 1 hour in 1 second 
intervals.

Active on Failure Check box that indicates whether the input channel should be active 
when failed.

Visibility
Show in Event 
Log

Visibility field that enables state reporting in the System Event Log.

Show in System 
Activity

Visibility field that enables state reporting in the System Activity window.

Input-Function
Function Function can be input_channel_bcast_req_fixed_zones, input_

channel_bcast_req_variable_zones, input_channel_local_fault_accept, 
input_channel_saf_playback_inhibit, input_channel_simple, or input_
channel_zone_selector. Input card parameters and connections are 
displayed below the Function box, when available.

Parameters
Broadcast ID Select from available broadcasts which broadcasts to enable.
Zone List Select from available zones which zones to apply the selected function.
Connection - Inputs
Add Connection Opens the Widget Input Details dialog box that allows you to add an 

input widget connection for the channel.
Enable Must be ACTIVE to allow the input to do anything.
Delatch De-latches a latched input or resets a toggled input.
Inhibit Inhibits the input.
Connection - Outputs
Add Connection Opens the Widget Input Details dialog box that allows you to add an 

output widget connection for the channel.
Raw State The physical state of the input before any inhibit has been applied.
State The logical state of the input.
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12.2.8 Adding a Widget
The following procedure is for advanced users only.

To add a Widget:

1.	 Click Add Connection. The Widget Input Details dialog appears.

Fields Description
Type The type of the entity needing a Widget, Input Card.
Name (ID) The index of the associated Input Card. The default value.
Channel Name 
(ID)

The Channel Number of the associated Input Channel. The default 
value.

Signal Select the Signal Name.
Add Click to add the new Widget.

3.	 Enter the fields.

4.	 Click Add.
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12.2.9 Configuration > Equipment > Output Card Channel
All of the Output Cards Channels have common configuration fields that you can modify 
from the specific Output Card items in the Equipment list. The Output Cards Channels 
include the Output Card Channel and Virtual Output Card Channel.

After creating an Output Card from the Equipment Configuration window, configure the 
specific Output Card channels by selecting the card listed under the Output Card list and 
adding an Output Card Channel.

Fields Description
Card ID Numerical Output Card ID. The range is 1-255.
Name User-defined Name for the Output Card Channel. The maximum length 

is 64 characters.
Comments Comments related to the specific Output Card Channel selected. The 

maximum length is 500 characters.
Scope Select either A Master, B Standby, Duplicated, or Shared.
Settings
Sense Sense for the Output Card Channel defines the behavior of the system 

when the signal is detected. Sense can be Normally Open/NDE or 
Normally Closed/NE.

Active on Failure Click the arrow to select the following: Active, Inactive, or Stay Same.
Active On Power-
Up/Reset

Click to define the initial state of the output.

Visibility
Show STATE in 
Event Log

Click to enable state reporting in the System Event Log.

Show STATE in 
System Activity

Click to enable state reporting in the System Activity window.

Output-Function
Function Click the arrow to select the following: output_channel_bcast_active_

all, output_channel_bcast_active_any, output_channel_bcast_slice_
detect, or output_channel_simple. Output card parameters and 
connections are displayed below Function box, when available.
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Fields Description
Parameters
Broadcast List Select from available broadcasts which broadcasts to enable.
Zone List Select from available zones which zones to apply the selected function.
Connection - Inputs
Add Connection Opens the Widget Input Details dialog box that allows you to add an 

input widget connection for the channel.
Inhibit Inhibits the output.
Drive Drives the output.
Connection - Outputs
Add Connection Opens the Widget Input Details dialog box that allows you to add an 

output widget connection for the channel.
State The logical state of the output.
Raw State The physical state of the output before any inhibit has been applied. 

Always the same as the “drive” input.
All Zones Active Output is active when all zones are playing specified broadcast.
Any Zone Active Output is active when any zone is playing specified broadcast.

12.2.10 Configuration > Equipment > Fan Monitor Card
The Fan Monitor Card monitors Fan operation in the system and reports faults if fans are 
not working correctly. Only Fans that are configured as fitted are monitored, see Top Row 
and Bottom Row for fitted fans.

To view or configure the Fan Monitor Card dialog box, click the card under the Fan 
monitor cards list.

Fields Description
Fan Monitor Card 
ID

Numerical Card ID. The range is 1-255.

Name User-defined Name for the Fan Monitor Card. The maximum length is 
64 characters.
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Fields Description
Comments Comments related to the specific Fan Monitor Card selected. The 

maximum length is 500 characters.
Scope Select either A Master, B Standby, Duplicated, or Shared.
Serial Communications
Bus ID Serial Communications Bus ID. The range is from 1 through 4.
Node ID Serial Communications Node ID. The range is from 1 through 63.
Timeout Period Sets the number of seconds until communication times out. The range 

is 1.0 to 26.5 seconds in 0.1 second steps.
Temperature
Fan On Sets the temperature at which fans turn on. The range is -30°C to 

100°C. Set Fan On greater than Fan Off to enable hysteresis.
Fan Off Sets the temperature at which fans turn off. The range is -30°C to 

100°C. Set Fan On greater than Fan Off.
Over Temp Fault Sets temperature at which Fan Monitoring Card reports an Overtemp 

Fault. The range is -30°C to 100°C.
Undertemp Fault Sets temperature at which Fan Monitoring Card reports an Undertemp 

fault. The range is -30°C to 100°C.
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12.2.11 Configuration > Equipment > Access Panel
All of the Access Panel have common configuration fields that you can modify from the 
specific Access Panel item in the Equipment list. The Access Panel includes the Access 
Panel and Soft Access Panel.

To view or configure the Access Panel dialog box, click the item under the Access Panels.

The Access Panel dialog box appears.

Fields Description
Access Panel ID Numerical Card ID. The range is 1-255.
Name User-defined Name for the Access Panel. The maximum amount is 

64 characters.
Comments Comments related to the specific Access Panel selected. The 

maximum amount is 500 characters. 
Location Read-only field that provides the system-defined location for the 

Access Panel.
Scope Select either A Master, B Standby, Duplicated, or Shared.
Slave Access Panel
This is a Slave 
Panel

Indicate that this Access Panel is a Slave Access Panel to a Master 
Access Panel. Click this box to open a window to select the Master 
Panel ID.

Master Access 
Panel ID

Only available when the current panel is selected as a Slave Panel. 
Use the spin box to select the ID of the Master Access Panel. The 
range is from 1 to 32.

Lost Comms Fault Suppressed
Is Lost Comms 
Fault Suppressed

Click to enable communication to be suppressed.

Save Click the Save button to ensure changes are saved to the System 
Manager.
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12.2.12 Configuration > Equipment > Access Panel Button
The Access Panel Button configuration dialog box is selected from the Equipment 
Configuration window by selecting one of the Access Panel Buttons. 

This dialog box allows you to do the following:

•	 Define how button selection on the Access Panel is recognized

•	 How the system responds to the button selection

•	 Any system operations or functions that need to be performed on button selection

To view or configure the Access Panel Button dialog box, click the item under Buttons.

Fields Description
Button ID Select the number of the button ID to configure. The range is from 

1-120.
Name User-defined Name for the Access Panel Button. The maximum length 

is 64 characters.
Comments Comments related to the specific Access Panel Button selected. The 

maximum length is 500 characters. 
Scope Select either A Master, B Standby, Duplicated, or Shared.
Settings
Sense Defines the behavior of the system after the button is selected. Options 

are Normally Open/NDE or Normally Closed/NE
Mode Defines the action supported by the system when the button is 

selected. Options are Direct, Toggled, or Latched.
Holdoff Time 
(Seconds)

Defines the amount of time that must pass before the input can be 
triggered after being cleared. The value can be set between 0 and 
1 hour in 1 second increments.

Minimum Active 
Time (Seconds)

Indicates the Minimum Time an action remains active after being 
initiated. The range is 0 to 1 in 1 second intervals.
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Fields Description
Maximum Active 
Time (Seconds)

Indicates the Maximum Time an action remains active after being 
initiated, if the activating signal is still active. Maximum Active numerical 
information is only visible when the corresponding check box is 
selected. The range is 0 to 1 in 1 second intervals.

Active on Failure Check box that indicates whether the button should be active when 
failed.

Visibility
Show STATE in 
Event Log

Click to enable state reporting in the System Event Log.

Show STATE in 
System Activity

Click to enable state reporting in the System Activity window.

Input-Function
Function Action that is initiated on the system when an associated event occurs. 

Function display is dependent on the Function selected. Options are 
input_channel_bcast_req_fixed_zones, input_channel_bcast_req_
variable_zones, input_channel_local_fault_accept, input_channel_
saf_playback_inhibit, input_channel_simple, or input_channel_zone_
selector. Output card parameters and connections are displayed below 
Function box, when available.

Parameters
Parameters differ based on the Function selected.

Zone 
Accumulator

Select from available zones which zones to enable. Available for 
function input_channel_zone_selector.

Zone List Select from available zones which zones to apply the selected function. 
Available for function input_channel_zone_selector.

Broadcast ID Select from available broadcasts which broadcasts to enable. Available 
under functions input_channel_bcast_req_fixed_zones and input_
channel_bcast_req_variable_zones.

Zone List Select from available zones which zones to apply the selected 
function. Available under functions input_channel_bcast_req_fixed_
zones and input_channel_bcast_req_variable_zones.

Connection - Inputs
Add Connection Opens the Widget Input Details dialog box that allows you to add an 

input widget connection for the channel.
Enable Must be ACTIVE to allow the input to do anything.
Delatch De-latches a latched input or resets a toggled input.
Inhibit Inhibits the input.
Select Accepts the input.
Connection - Outputs
Add Connection Opens the Widget Output Details dialog box that allows you to add an 

output widget connection for the channel.
State The logical state of the input. 
Raw State The physical state of the input before any inhibit has been applied.
Save Click the Save button to ensure changes are saved to the System 

Manager.
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12.2.13 Configuration > Equipment > Access Panel Indicator
The Access Panel Indicator configuration dialog box is selected from the Equipment 
Configuration window by selecting one of the Access Panel Indicators. 

To view the Access Panel Indicator Configuration dialog box, click an item under Access 
Panels Indicators from the list.

Fields Description
Indicator ID Numerical Card ID. The range is 1-255.
Name User-defined Name for the Access Panel Indicator. The maximum 

length is 64 characters.
Save Click the Save button to ensure changes are saved to the System 

Manager.
Output-Function
Function Click the arrow to select the function. Output card parameters and 

connections are displayed below Function box, when available. Options 
are indicator_bcast_slice_detect, indicator_healthy, indicator_minor_
fault, indicator_major_fault, or indicator_simple.

Parameters
Max Active Secs Maximum number of seconds active.
Widget ID ID of control widget that drives the input for this indicator. Widget ID is 

only available when indicator type is indicator_bcast_slice_detect.
Connections-Inputs
Add Connection Opens the Widget Input Details dialog box that allows you to add an 

input widget connection for the channel.
Blink Causes the indicator to blink.
Blink If Drive Causes the LED to blink if drive is also on.
Drive Drives the LED ON. This overrides the BLINK input.
Lamp Test Drives the LED indicator solid ON, unconditionally. This overrides all 

other inputs.
Connections-Outputs
Standard LEDs have no Connections-Outputs, but some non-standard LEDs, such as 
Function indicator_minor_fault (and major/healthy) may have output functions.
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Fields Description
Save Click the Save button to ensure changes are saved to the System 

Manager.

12.2.14 Configuration > Equipment > Access Panel Mux Card
The Access Panel Mux configuration window is selected from the Equipment 
Configuration window by selecting the Access Panel Mux card.

To view the Access Panel Mux Configuration dialog box, click an item under Access 
Panel Mux Card from the list.

Fields Description
Name User-defined Name for the AP Mux Card.
Comments Comments related to the specific AP Mux Card selected. 
Scope Select either A Master, B Standby, Duplicated, or Shared.
Serial Communications
Timeout Period 
(Secs)

Serial Communications timeout period. The range is from 1.0 to 
26.5 seconds in 0.1 second steps.

Type/Location Displays the type of AP Mux card and Controller slot used by the card. 
Select from the following:
•	 Internal AP Mux – Slot 1
•	 Internal AP Mux – Slot 2
•	 External AP Mux – Slot 1, Aggregator ID 1
•	 External AP Mux – Slot 1, Aggregator ID 2
•	 External AP Mux – Slot 2, Aggregator ID 1
•	 External AP Mux – Slot 2, Aggregator ID 2

Access Panels 
Supported

A read-only field that is dependent on the Type/Location of AP Mux 
card. Values are as follows:
•	 1-8 for Internal AP Mux – Slot 1
•	 17-24 for Internal AP Mux – Slot 2
•	 1-8 for External AP Mux – Slot 1, Aggregator ID 1
•	 9-16 for External AP Mux – Slot 1, Aggregator ID 2
•	 17-24 for External AP Mux – Slot 2, Aggregator ID 1
•	 25-32 for External AP Mux – Slot 2, Aggregator ID 2
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Fields Description
Card ID A read-only field that is dependent on the Type/Location of AP Mux 

card. Values are as follows:
•	 1 for Internal AP Mux – Slot 1
•	 3 for Internal AP Mux – Slot 2
•	 1 for External AP Mux – Slot 1, Aggregator ID 1
•	 2 for External AP Mux – Slot 1, Aggregator ID 2
•	 3 for External AP Mux – Slot 2, Aggregator ID 1
•	 4 for External AP Mux – Slot 2, Aggregator ID 2

Save Click the Save button to ensure changes are saved to the System 
Manager.

12.2.15 Configuration > Equipment > Misc Card
The Misc Card configuration window is selected from the Equipment Configuration 
window by selecting the Misc card.

To view the Misc Configuration dialog box, click an item under Misc Card from the list.

Fields Description
Misc Card 
(PABX) ID

The range is 1-255.

Name User-defined name of the Misc card.
Comments User-defined Comments for the specified Misc Card.
Scope Select either A Master, B Standby, Duplicated, or Shared.
Serial Communications
Bus ID Displays the Bus ID for the Misc Card Group. The range is 1-4.
Node ID Displays the Node ID for the Misc Card Group. The range is 1-63.
Timeout Period 
(secs)

Displays number of seconds until communication times out. The range 
is 1.0 to 26.5 seconds in 0.1 second steps.

Telephone Settings
Line Mode Click either the Analog Extension or Tunk Loop Start option.
Welcome Prompt Select the message to initially welcome the user on the PABX 

telephone handset.
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Fields Description
Message 
Broadcast

Select the message to broadcast to the user on PABX telephone 
handset.

Maximum Page 
Duration (Secs)

Maximum length of page, in seconds. The max is 600 seconds in steps 
of 5 seconds.

Max Playback 
Waiting Period 
(Secs)

Maximum period of time to wait before starting playback. The max is 
600 seconds in steps of 5 seconds.

Trim Message 
Ending (Secs)

The number of seconds (between 0.1 and 10 seconds, in 0.1 seconds 
increments) to trim the page.

Detect Caller Hang Up
On Line Break 
Reversal

Enables detection of line break / reversal.

On DTMF Key Enables DTMF key entry. Selecting this check box displays the Select 
DTMF Key field.

Select DTMF Key Defines the DTMF key code value used to hang-up if HANGUP ON 
DTMF TONE is enabled.

On Call Progress 
Tone

Enables call progress tone. Selecting this check box displays Cadence 
Timing and Timing Margin.

Abort Call
On Line Break / 
Reversal

Enables detection of line break / reversal.

On DTMF Key Enables DTMF key entry. Selecting this check box displays Select 
DTMF Key.

Select DTMF Key Defines the DTMF key code value used to hang-up if HANGUP ON 
DTMF TONE is enabled.

Cadence Timing 
(Secs)

Define cadence patterns to be matched to abort call.

Timing Margin 
(ms)

Timing margin to allow when measuring Cadence Timing.

Skip Welcome
Select DTMF Key Defines the DTMF key code value used to hang-up if HANGUP ON 

DTMF TONE is enabled.
Zone Selection
Add New Record Opens the New Zone dialog box that allows you to create a new zone. 
Default Zone Select the default zone for the PABX broadcasts.
Save Click the Save button to ensure changes are saved to the System 

Manager.
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12.2.16 Adding a new Zone
To add a new Zone:

1.	 Click Add New Record. The New Zone dialog appears.

Fields Description
Name User-defined name of the Zone.
Comments User-defined comment.
DTMF Key Enter DTMF value to select this Zone.
Zones Enter Zone.
Update Adds the newly configured Zone and exits the New Zone window. 
Cancel Cancels the creation of a new Zone and exits the New Zone 

window.

3.	 Enter the fields.

4.	 Click Add.
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12.3 Configuration > Broadcasts
The Broadcast configuration window allows you to create and configure broadcasts to 
use in alarming and paging. When entering this window, the existing Broadcasts are 
displayed in the dialog box on the left side of the window. The dialog box includes the 
Description, Type, and Priority of the existing Broadcasts, an Edit button that allows you 
to make changes to an existing broadcast, and a Delete button that allows you to delete an 
existing broadcast. 

To display the attributes of an existing Broadcast: select a Broadcast from the dialog box 
on the left side of the window. The attributes of the Broadcast displays on the right side 
of the window: Description, Globally Attenuable, Primary and Backup Sequences. 

To create a new Broadcast record or create a new primary or backup sequence for an 
existing record: click the Add new record button.

Fields Description
Add new record Opens the New Broadcast dialog box that allows you to create a new 

broadcast. 
Id User-defined ID number. ID must be unique.
Description User-defined description for the selected Broadcast.
Type The Type of the Broadcast. Types include Emergency Page, Alarm, 

Priority Page, Duckable Alarm, Routine Page, Routine Message, or 
Program Audio.

Priority Priority of the selected Broadcast. Lower numbers are higher priority.
Description User-defined description for the selected Broadcast.
Ducking 
Attenuation (DB)

Only available when the duckable alarm is selected. Enter the 
Attenuation (DB) to reduce the duckable alarm in volume while the 
Emergency Page is active. After the Emergency Page is completed, the 
duckable alarm will return to normal volume.

Globally 
Attenuable

Indicates that the broadcast level may be reduced (attenuated) 
throughout the scope of the installation.

Primary Sequence
Add new record Opens the New Primary Sequence dialog box that allows you to create 

a new sequence.
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Fields Description
Source Can be Silence, any Audio Input available, or recorded messages.
Max For recorded messages, the message loop until the maximum duration 

has elapsed. If a maximum duration is not defined or zero, the 
message plays once. For live audio inputs, the maximum duration can 
be specified for timeout. When the maximum duration has elapsed, the 
sequence progresses to the next step (or jump, if provisioned). Default 
is no maximum duration.

Jump If a different step in the Broadcast sequence is needed to play next, 
this field identifies the next step. This allows repetitions and looping 
sequences. If not configured, the sequence follows the next step.

Backup Sequence
Add new record Opens the New Backup Sequence dialog box that allows you to create 

a backup sequence.

12.3.1 Adding New Broadcasts
Selecting Add new record on the Configuration > Broadcast dialog box allows you to add 
new Broadcast. 

To create a new broadcast: 

1.	 Click Add new record. The New Broadcast dialog box appears.

Fields Description
ID The ID number. The ID number of the Broadcast is not repeatable.
Name User-defined name of the Broadcast.
Broadcast Type The Type of the Broadcast. Types include Emergency Page, 

Alarm, Priority Page, Duckable Alarm, Routine Page, Routine 
Message, or Program Audio.

Comment User-defined comment.
Priority Priority of the Broadcast. Lower numbers are higher priority.
Is Mutable Broadcast can be muted when higher priority broadcast is needed.

2.	 Enter the fields.

3.	 Click Update.
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12.3.2 Adding a New Primary Sequence
Selecting Add new record in the Primary Sequence section on the Configuration > 
Broadcast dialog box allows you to add a new Primary Sequence. 

To create a new broadcast: 

1.	 Click Add new record. The New Primary Sequence dialog box appears.

Fields Description
ID Displays the ID number. The ID number of the Broadcast is not 

repeatable.
Source Click the arrow to select the AUDIO INPUTS and RECORDED 

MESSAGES.
Source Scope Click the arrow to select from the available options. Options 

available are any audio inputs that have been defined.
Duration in Ms Use the spin box to select the duration of the broadcast.
Next Slice ID Use the spin box to select the next slice ID. Set this field to 1 to 

recursively repeat this sequence, or set it to the next sequence to 
initiate after this sequence.

Widget Use the spin box to select the widget.

2.	 Enter the fields.

3.	 Click Update.
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12.4 Configuration > Zones
The Zone configuration dialog box allows you to create new zone entries and delete 
existing ones.

To view the Zone Configuration dialog box, click Zones.

Fields Description
Add new record Select Add new record. The New Zone dialog box appears allowing 

you to choose from options to create a new Zone. Group Zones by any 
column (#, Name, or Comments) by moving the desired grouping field 
column header into the grouping area at the top of the Zone Config 
window.

Edit icon Select the Edit icon. The Edit Zone dialog box appears allowing you to 
edit the ZoneNumber, Name, and Comments.

Delete icon Select the Delete icon. Deletes the selected Zone. 

12.4.1 Adding New Zones
Selecting Add new record on the Zone configuration dialog box allows you to add new 
Zones. Each Zone has a Zone Number, Name, and Comments.

To create a new zone: 

1.	 Click Add new record. The New Zone dialog box appears.
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Fields Description
Zone Number Enter user-defined Zone number. The range is from 1 to 128. Zone 

0 exists by default, cannot be deleted, and all standby amplifiers 
belong to Zone 0. Zone IDs must be unique within the system.

Name User-defined name of the Zone.
Comments User comment related to selected Zone.
Update Adds the newly configured Zone and exits the Zone Edit window. 
Cancel Cancels the creation of a new Zone and exit the Zone Edit window.

2.	 Enter the Zone Number, Name, and Comments.

3.	 Click Update.

12.4.2 Editing Zones
To edit an existing item from the equipment configuration dialog box, click the item and 
click edit.

To edit a zone: 

1.	 Click the item. Click Edit. The Edit dialog box appears.

Fields Description
Zone Number Enter user-defined Zone number. The range is from 1 to 128. Zone 

0 exists by default, cannot be deleted, and all standby amplifiers 
belong to Zone 0. Zone IDs must be unique within the system.

Name User-defined name of the Zone.
Comments User comment related to selected Zone.
Update Adds the newly configured Zone and exits the Zone Edit window. 
Cancel Cancels the creation of a new Zone and exit the Zone Edit window.

2.	 Edit the Zone Number, Name, and Comments.

3.	 Click Update.

12.4.3 Deleting Zones
To remove an existing item from the equipment configuration dialog box, click the item 
and click Delete.
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12.5 Configuration > Audio
The Audio configuration window allows you to create the following:

•	 Audio Inputs

•	 Recorded Messages

•	 Compressors

•	 Audio Outputs

12.5.1 Configuration > Audio > Audio Inputs
The Audio Inputs dialog box allows you to add new Audio Inputs for the system. Each 
Audio Input has a Scope, Hardware Name, Description, and Compressor to use on the 
Audio Input signal.

To view the Audio Inputs dialog box, click Configurations > Audio > Audio Inputs.

Fields Description
Add new record Opens the New Audio Input dialog box that allows you to choose 

from system-defined audio input options.
Scope Enter the Scope of the Audio Input, relative to the system type, and 

dependent on scope rules that prevents overlapping Audio Inputs. 
Options are as follows:
•	 A Master
•	 B Standby
•	 Duplicated
•	 Shared

Hardware Name System-defined name and is not editable.
Description User-defined description of the Audio Input.
Compressor Compressor selection options are based on Compressors that are 

defined on the Compressors configuration window, discussed later.
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Fields Description
Edit icon Select the Edit icon. The Edit Audio Input dialog box appears, 

allowing you to edit the Input Type, Hardware Name, Pilot Tone 
Threshold, Scope, Compressor, Is Pilot Tone Enabled, Gain Trim, 
and Comments.

Delete icon Deletes the selected Audio Input. 

Edit Gain and 
Pilot Tone

Select the Edit Gain and Pilot Tone text at the bottom of the 
window to transition to the Field Diagnostics > Audio Input 
window. See the Field Diagnostics > Audio Input section for more 
information.

12.5.2 Adding New Audio Inputs
Selecting Add new record on the Audio Input dialog box allows you to add new Audio 
Inputs.

To create a new audio input: 

1.	 Click Add new record. The New Audio Input dialog box appears.

Fields Description
Hardware Name User-defined name of the Audio Input.
Input Type Broadcast Source or A/B Path.
Input ID Select from a list of options based on the Input Type selected.
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Fields Description
Scope Enter the Scope of the Audio Input, relative to the system type, and 

dependent on scope rules that prevents overlapping Audio Inputs. 
Options are as follows: 
•	 A Master 
•	 B Standby 
•	 Duplicated 
•	 Shared

Compressor Compressor selection options are based on Compressors that are 
defined on the Compressors configuration window, discussed later.

ls Pilot Tone 
Enabled

Click to enable Pilot Tone detection on this Audio Input.

Comment User comment related to selected Audio Input.
Local Properties
Add new record Opens the New Local Properties dialog box that allows you to 

choose the Scope, Gain Trim, and Pilot Tone Threshold.
Scope Enter the Scope of the Audio Input, relative to the system type, and 

dependent on scope rules that prevents overlapping Audio Inputs. 
Options are as follows: 
•	 A Master 
•	 B Standby 
•	 Duplicated 
•	 Shared

Gain Trim The value to trim the gain (for example, to compensate for losses 
in the cabling). Range is 6 to -30 in 1 dB increments.

Pilot Tone 
Threshold

The limit where a fault is raised when the measured Pilot Tone 
level is below the limit. Range is 0.0 to -100.0 in 0.1 dB.

Update Adds the newly configured Audio Input and exits the Audio Input 
window. 

Cancel Cancels creation of a new Audio Input and exit the Audio Input 
window.

2.	 Enter the fields.

3.	 Click Update.
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12.5.3 Adding New Local Properties
Selecting Add new record on the New Local Properties dialog box allows you to add new 
local properties.

To add new local properties:

1.	 Select Add New Record. The New Local Properties dialog box appears.

3.	 Select the Scope, Gain Trim, and Pilot Tone Threshold.

4.	 Click Update.

12.5.4 Editing Audio Inputs
Selecting Edit on the Audio Input dialog box allows you to edit the selected Audio Inputs.

To edit an Audio Input:

1.	 Select the Audio Input to edit.

2.	 Click the Edit icon. The Edit Audio Input dialog box appears for the hardware name 
selected.
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3.	 Edit the fields.

4.	 Click Update.

12.5.5 Configuration > Audio > Recorded Messages
The Recorded Messages window allows you to add new Audio Files for the system. 
When the System Manager connects to the PAGASYS GEN II Controller, it downloads 
the configuration file from the Controller, which includes filenames for the audio files. 
Once the Recorded Message filenames are available, the System Manager downloads the 
audio files from the Controller and stores them in a local System Manager’s database. 
If new audio files are imported into the System Manager (using the To/From Controller 
text), they must be uploaded to the Controller using the Upload button to be retained in 
the system.

To view the Audio Files dialog box, click Configurations > Audio > Recorded Messages.

Fields Description
Add new record Opens a dialog box that allows you to enter Recorded Message 

options.
Description User-defined description of the recorded message. This 

description was entered in the New Message dialog box.
File Name User-defined file name for the Recorded Message. This file name 

was entered in the New Message dialog box.
Export File Click to export a Recorded Message file currently in the system to 

the local computer. 
Import File Click to import a Recorded Message file currently on the local 

computer into the system. The system verifies the file type 
specified in the dialog box, transcodes the audio to raw sample 
data, and calculates the CRC of the raw sample data, before 
storing the file in the local system database.

Size Displays the Size of the Recorded Message. The Size is calculated 
from the imported file.

Length Displays the Length of the Recorded Message. The Length is 
calculated from the imported file.
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Fields Description
To/From 
Controller

Uploads or downloads a Recorded Message to the Controller. Can 
contain one of two values:
•	 Upload – The Controller is connected, but does not contain a 

matching file. Click Upload to upload the Recorded Message 
raw audio file into the Controller. Files Imported in the System 
Manager, but not uploaded, are not retained by the Controller.

•	 Download – The Controller is connected, and does contain 
a matching file. Click Download to download the Recorded 
Message raw audio file from the Controller to the System 
Manager database.

Play icon Plays the Recorded Message on the local computer.

Edit icon Select Edit. The Edit Message dialog box appears, allowing you to 
edit the Name, Description. File Name, and File CRC.

Delete icon Deletes the Recorded Message from the System Manager’s 
database and from the Controller.

12.5.6 Adding new Recorded Messages
The Add new record New Message dialog box allows you to add new Recorded 
Messages for the system. 

To add a new recorded messages:

1.	 Click the Add new record button. The New Message dialog box appears.

Fields Description
Name Enter in the name of the Recorded Message.
File Name File name for the Recorded Message. Click the Browse 

button to search the database for a file name.
File CRC CRC for the Recorded Message, which is calculated from 

the imported file.
Update Adds the new Recorded Message record to the Recorded 

Messages tab.
Cancel Cancels the Add new Recorded Message action and return 

to the Recorded Messages tab.
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2.	 Enter the fields.

3.	 Click Update.

12.5.7 Editing Recorded Messages
Selecting Edit on the Recorder Message dialog box allows you to edit the selected 
Recorder Message.

To edit a Recorder Message:

1.	 Select the Recorder Message to edit.

2.	 Click the Edit icon. The Edit Messages dialog box appears for the file name selected.

3.	 Edit the fields.

4.	 Click Update.
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12.5.8 Configuration > Audio > Compressors
The Compressors dialog box allows you to add new Compressors for the system. Audio 
Compression is used to lessen the dynamic range between the loudest and quietest parts 
of an audio signal.

To view the Compressors dialog box, click Configurations > Audio > Compressors.

Fields Description
Add new record Opens a dialog box that allows you to enter Compressor options.
Description User-defined description of the audio Compressor.
Ratio Compression ratio desired. The range is 1 to 60 in steps of 0.1
Threshold The dB threshold value where the compression begins to be 

applied. The range is 0 to -100 dBFS in steps of 1. 
Attack How quickly the compressor begins to start compression after the 

audio signal reaches the threshold. The range is from 1 to 50 ms in 
steps of 1.

Release How quickly the compressor stops compression after the audio 
signal drops below the threshold. The range is from 10 to 2000 ms 
in steps of 10.

Edit icon Select Edit. The Edit Message dialog box appears allowing you to 
edit the Name, Ratio, Threshold, Attack, Release, and Comment.

Delete icon Deletes the selected Compressor from the System Manager’s 
database and from the Controller.
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12.5.9 Adding new Compressors
The new Compressor dialog box allows you to add new Compressors for the system. 

To add a new Compressor: 

1.	 Click Add new record button. The New Compressor dialog box appears.

Fields Description
Name Enter the Name for the new Compressor.
Ratio Enter compression ratio desired. The range is 1 to 60 in steps of 

0.1.
Threshold Enter the dB threshold value where the compression will begin to 

be applied. The range is from 0 to -100 dBFS in steps of 1.
Attack Enter how quickly the compressor begins to start compression 

after the audio signal reaches Threshold. The range is 1 to 50 ms 
in steps of 1.

Release Enter how quickly the compressor stops compression after the 
audio signal drops below the Threshold. The range is from 10 to 
2000 ms in steps of 10.

Comment Enter a comment related to selected new Compressor.
Update Adds the new Compressor record to the Compressor configuration 

window.
Cancel Cancels the Add new Compressor action and return to the 

Compressor configuration window.

2.	 Enter the fields.

3.	 Click Update.
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12.5.10 Editing Compressors
Selecting Edit on the Compressors dialog box allows you to edit the selected Compressor.

To edit a Compressors:

1.	 Select the Compressors to edit.

2.	 Click Edit. The Edit Compressor dialog box appears for the file name selected.

3.	 Edit the fields.

4.	 Click Update.
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12.5.11 Configuration > Audio > Audio Outputs
The Audio Outputs configuration dialog box allows you to configure Audio Output 
routing for the system. Each Audio Output has an Audio Output Name, a Zone 
Assignment, and a Pilot Tone Level dBFS (slide bar and digital). The grid of Audio 
Outputs may be initially populated with the following Audio Outputs (user can add or 
remove Audio Outputs):

•	 1 A/B Link (Global)

•	 6 Amplifier Paths

•	 1 Aux Out

•	 16 Dante Network Channels

Fields Description
Add new record Opens a dialog box that allows you to enter Audio Output options.
Scope Scope of the audio output. Options include A Master, B Standby, 

Duplicated, or Shared.
Audio Output 
Name

Hardware-defined name for the Audio Output.

Zone Assignment The path for the output. Amplifier paths can be Standard or a Zone 
may be selected. All other outputs must have a zone (A/B Paths 
have a pseudo-zone ID, for example 101, 102, and so forth. This is 
used internally and must not match any defined zone).

Pilot Tone Level 
dBFS

User programmable Pilot Tone Level. The range is -100 to 0 in 
steps of 0.1.

Edit icon Select Edit. The Edit Audio Output dialog box appears allowing you 
to edit the Scope Name, Audio Output Name, Output Type, Zone, 
and Pilot Tone Type.

Delete icon Deletes the selected Audio Output from the System Manager’s 
database and from the Controller.



85
SYSTEM MANAGER Description, Installation, and User Manual 
Federal Signal www.fedsig.com

Using Configuration

12.6 Configuration > Faults
The PAGASYS GEN II system will process faults based on Rule ID, where the highest-
numbered rule will be compared to the fault under consideration, followed by the next 
highest-numbered rule, all the way down to the lowest-numbered rule. The lowest-
number rule will typically have a wildcard entry for all fault fields to ensure it applies to 
any fault not allocated to a higher-numbered rule. 

To access the Faults window, click the Faults tab.

Fields Description
Add new record Opens a dialog box that allows you to enter Fault options.
Rule ID ID of the rule which is used to evaluate faults.
Scope Options include A Master, B Standby, Duplicated, or Shared.
Fault Type Fault types which are device dependent.
Device Type Device type for status reporting.
Device ID Device ID for Device Type reporting.
Sub ID Sub ID under Device ID.
Classification Options include Always Major, Always Minor, Conditionally, Major.
Comments User-defined comments.
Edit icon Select Edit. The Edit Fault dialog box appears allowing you to edit 

the Rule ID, Scope, Fault Type, Device Type, Device ID, Sub ID, 
Classification, and Comments.

Delete icon Deletes the selected Fault from the System Manager’s database 
and from the Controller.
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12.7 Configuration > Status
To access the Status window, click the Faults Status.

Fields Description
Controller A (→) or B (←) controller reporting status.
Device Type Device type for status reporting.
Device ID Device ID for Device Type reporting.
Sub ID Sub ID under Device ID.
Name Name of status item.
Show in Event Log Select to show item in Event Log.
Show in Sys Activity Select to show item in Sys Activity.
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12.8 Configuration > Control Panel Designer
The Control Panel Designer configuration dialog box allows you to create and edit new 
Control Panels for the System Manager. When entering the Control Panel Designer 
window, the default Control Panel view is available for editing. 

Use the controls on this window to do the following:

•	 Create new Control Panels

•	 Change the active Control Panel

•	 Edit existing Control Panels

Fields Description
View / Selected 
View

Click the down arrow to select your view and bring it into the 
Control Panel Designer for editing. View Type will be set to View 
for normal access panel, or GapView for global access panel.

View / Selected 
Access Panel

Click the down arrow to select your access panel and bring it into 
the Control Panel Designer for editing.

View / Default 
View

Select the Default View check box to make the current View in the 
Control Panel Designer the default View. 

View / Remove Deletes the current View in the Control Panel Designer.
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Fields Description
View / Enter View 
Name

Enter the name of the current View.

View / Select 
View Type

Click the down arrow to select your view type.

View / Selected 
Access Panel

Click the down arrow to select your access panel and bring it into 
the Control Panel Designer for editing.

View / New Saves the current View. The name will display in the Selected View 
drop-down.

Fields Description
Design / + Adds a new item of selected type to the active Control Panel. 

Select the design:
•	 Line
•	 Filled Box
•	 Label
•	 Image 
•	 LED
•	 Background Image
•	 Button
Click the + button to place the design onto the active Control 
Panel.

Design / Clear All Removes all items from the active Control Panel.
Design / Remove 
Item

Removes the selected item from the active Control Panel.

Design / Reset Resets active view to last saved version.
Design / Lock All Locks active view in place. Button changes to Unlock All.

Fields Description
Elements / Label Displays and allows you to select the Label items on the active 

Control Panel.
Elements / LED Displays and allows you to select the LED item on the active 

Control Panel.
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Fields Description
Elements / Button Displays and allows you to select the Button item on the active 

Control Panel.
Elements / Image Displays and allows you to select the Image item on the active 

Control Panel.
Elements / Filled 
Box / Line

Displays and allows you to select the Filled item on the active 
Control Panel.

Fields Description
Properties / 
Object ID

Displays the ID number of the object on the active Control Panel.

Properties / 
Control Type

Displays the type of item created in the Design window (for 
example, Label, LED, or Button). The Control Type cannot be 
changed after creation.

Properties / 
Height

Sets the height attribute of the selected object.

Properties / 
Width

Sets the width attribute of the selected object.

Properties / Left Sets the distance from the left side of the active view of the 
selected object.

Properties / Top Sets the distance from the top of the active view of the selected 
object.



90    
PAGASYS GEN II (P-SYSMGR-G) 

Federal Signal www.fedsig.com

Using Configuration

Fields Description
Properties / Label 
Text

Type the name of the item.

Properties / Font Click the arrow to select a font.
Properties / Font 
Size

Sets the font size.

Properties / Font 
Style

Sets the styles as bold, italic, or underline.

Properties / Font 
Alignment

Sets the font alignment as align left, align center, align right, or 
justify all lines.

Properties / 
Font Horizontal 
Alignment

Sets the font alignment as align top, align middle, or align bottom.

Properties / Label 
Color

Click the down arrow to select the color of the label.

Properties / 
Background 
Color

Click the down arrow to select the color of the background.

Properties / 
Border Color

Click the down arrow to select the color of the border.

Properties / 
Border

Sets the size of the border.

Properties / 
Button Radius

Sets the button radius.

Properties / Is 
Confirmation 
Needed

Click to cause the control panel to confirm action when button is 
clicked.

Properties / 
Controller ID

Click the down arrow to select the Controller ID.

Fields Description
Can Navigate / 
Can Navigate

Click this box if selecting this item on the Control Panel needs to 
transition to a new Control Panel view. This attribute is only an 
option for buttons.

Can Navigate /
Navigate To View

Select the desired view for the Can Navigate attribute of a button.

Can Navigate /
Target

Select type of window for the new navigation window: Popup, 
Blank, or Self.
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Fields Description
Import View / 
New View Name

Enter a View Name.

Import View / 
Select View Type

Click the down arrow to select your view type.

Import View / 
Selected Access 
Panel

Click the down arrow to select the access panel.

Import View / 
Select files

Click the button to open a file browser window to select 
initialization (json format) file for a new View.

Import View / 
New

Click the New button to create new view with New View Name.

Fields Description
Export View / 
Select View

Select a View Name.

Export View / 
Export

Click the Export button to export the current View.

Fields Description
Snap to Grid Click this box to force items to snap to grid layout of the Control 

Panel window.
Save Saves the new or changed attributes for a object.



92    
PAGASYS GEN II (P-SYSMGR-G) 

Federal Signal www.fedsig.com

Using Configuration

12.9 Configuration > Functions
The Functions configuration dialog box allows you to create processes that can initiate 
system actions when an event occurs. For example, when a Broadcast is occurring in a 
specific zone, the function could enable notification lights in the zone by driving a signal 
to an Output Card.

The initial entry window to the Functions configuration dialog box shows any existing 
Functions already present in the system. The dialog box displays Function ID, Scope, 
Type, and Name.

Fields Description
+ Add new record Select to display the New Function dialog box to add a new function.
ID User-defined Function ID number. ID must be unique for Functions 

of a given type.
Scope Displays the Scope of the Function, relative to the system type. 

Options are as follows: 
•	 A Master 
•	 B Standby 
•	 Duplicated 
•	 Shared
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Type Displays the Function Type needed to initiate the Function. Available 
Function Types include:
•	 all_of
•	 bcast_req_fixed_zones
•	 bcast_req_variable_zones
•	 bcast_slice_detect
•	 broadcast_active
•	 broadcast_requested
•	 fault_state
•	 inhibit
•	 local_fault_accept
•	 saf_playback_inhibit
•	 system_state
•	 none_of
•	 user_fault
•	 zone_selector

Name User-defined Name for the Function.

When the Add new record button is selected on this window, the System Manager opens 
a dialog box allowing you to enter new Function attributes. See section on Creating a 
New Function Attribute.

When one of the existing Functions is selected, the window below the Function List 
shows the selected Function attributes. See table.

Fields Description
Function Details
Name User-defined Name for the Function.
Comments User-defined Comment that describes the function task.
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Fields Description
Function Type Select the Function Type needed to initiate the Function. Available 

Function Types include:
•	 all_of
•	 bcast_req_fixed_zones
•	 bcast_req_variable_zones
•	 bcast_slice_detect
•	 broadcast_active
•	 broadcast_requested
•	 fault_state
•	 inhibit
•	 local_fault_accept
•	 saf_playback_inhibit
•	 system_state
•	 none_of
•	 user_fault
•	 zone_selector

ID User-defined Function ID number. ID must be unique for Functions of a 
given type.

Parameters Parameters will differ dependent on function type.
Connection - 
Inputs

Inputs associated with the function

Connection - 
Outputs

Outputs associated with the function

Add Connection Opens the Widget Input Details dialog box that allows you to add an 
input widget connection for the channel.

Save Click the Save button to ensure changes are saved to the System 
Manager.
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12.9.1 Creating a New Function Connection
To create a new function attribute: 

1.	 Click the Add Connection button. The Widget Input Details dialog box appears.

2.	 Enter the new functions attributes.

Fields Description
Type The type of the entity needing a Widget, Input Card.
Name (ID) The index of the associated Input Card. The default value.
Channel Name 
(ID)

The Channel Number of the associated Input Channel. The default 
value.

Signal Select the Signal Name.
Add Click to add the new Widget.

3.	 Enter the fields.

4.	 Click Add. 
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13.0 Using Field Diagnostics
The Field Diagnostics component is responsible for displaying diagnostics options to you 
for all system hardware, including the beacon monitors and ISMTs. The Field Diagnostics 
window allows you to run diagnostics on Equipment, Audio Inputs, or Audio Outputs.

To access the Field Diagnostics window, click Field Diagnostics.

13.1 Field Diagnostics > Equipment
The Field Diagnostics component allows you to perform diagnostics operations on 
equipment in the system cabinet. If the system includes redundant equipment (A and B 
versions), Field Diagnostics displays all redundant versions of hardware, and diagnostics 
information is specific to the actual hardware selected.

To access the Equipment window, click Field Diagnostics > Equipment.

Field 
Diagnostics
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13.1.1 Field Diagnostics > Equipment > Controller
Select one of the Controllers from the Equipment list on the left side of the Field 
Diagnostics Equipment window. The Controller fields on the Diagnostics window are 
related to Basic Information and Network Configuration.

Fields Description
Manufacturing Details
Hardware Serial 
Number

Serial number for the specified Controller.

Firmware Version Firmware version for the specified Controller.
Firmware Commit Firmware commit for the specified Controller.
Basic Information
Controller ID User-defined ID for the specified Controller.
Name User-defined Name for the specified Controller. 
Config Serial 
Number

Serial number for the specified Controller.

Comments User-defined Comments for the specified Controller.
Network Configuration
IP Address IP Address for the specified Controller.
Net Mask Controller Net Mask.
Default Gateway Controller Default Gateway.
IP Version Version used on the PAGASYS GEN II system. Select either 

version IPv4 or IPv6.
Controller Time
Time
Sync To PC 
Time

Syncs the time to the specified Controller.
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13.1.2 Field Diagnostics > Equipment > Amplifier Group
Select one of the Amplifier Groups from the Equipment list on the left side of the Field 
Diagnostics Equipment window. The Amplifier Group fields on the Field Diagnostics 
window displays only Basic Information.

Fields Description
Basic Information
Name User-supplied Name for the specified Amplifier Group.
Comments User-defined Comments for the specified Amplifier Group.

13.1.3 Field Diagnostics > Equipment > Amplifier
Select one of the Amplifiers from the Equipment list on the left side of the Field 
Diagnostics Equipment window. The Amplifier fields on the Field Diagnostics dialog box 
displays Manufacturing Details, Gain Control fields, Fan Status, Override Automatic Fan 
Control, Power Switch status, Internal DC Power Supply status, Amplifier Temperature 
status, Critical Path (Pilot Tone) Monitoring status, and Impedance Monitoring status or 
Speaker status depending on monitoring option selected for the amplifier in configuration.

Manufacturing Details include all manufacturing specific information for the selected 
Amplifier card. These Manufacturing Details are requested by the System Manager at 
initial entry to this window, and can be refreshed by selecting the character and reported 
back to the System Manager by the selected Amplifier card in the system cabinet. 
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Fields Description
Manufacturing Details
Serial Number Reported Serial Number for the specified Amplifier card.
Part Number Reported Part Number for the specified Amplifier card.
Board Build Date Reported Board Build Date for the specified Amplifier card.
Firmware Version Reported Firmware Version for the specified Amplifier card.
Firmware Commit Reported build number for the specified Amplifier card.
Gain Control
Gain Move the Gain indicator, or use the directional arrows on the on the 

Gain display bar to change the Gain value. Changing the Gain value 
increases or reduces the output of the amplifier. The Gain value is 
displayed digitally on the right side of the Gain display bar. The range is 
-30 to +0 in steps of 1 dB. Click the Go button to update the Gain value 
on the Amplifier.

Fan Status
Fan Status Displays status of the Amplifier Fans. When the fans are at rest, Fan 

Status show a no symbol  in the Running column, and RPM at 
0. When fans are operating, the Fan Status has a check mark in the 
Running display, and RPM reflects the Amplifier fan speed.

Override 
Automatic Fan 
Control

Allows you to override the normal system control of the Amplifier Fans. 
(See Temperature below for Automatic Fan Control specifications). 
Select a time period to force the Amplifier Fans to operate. Values are 
15 seconds, 30 seconds, 2 minutes, 3 minutes, or 5 minutes. Once the 
time period is selected, click Force Fan On to start Fan operation. You 
should see the Fan Status change to an operating status, while the 
Time Remaining field counts down to the selected time period. Fans 
automatically stop operating at completion of the time count down.

Power Switch
Power Switch The Amplifier cards each have a Power Switch indicator on their 

chassis display, but this Power Switch is normally not enabled. Select a 
time period to enable the Power Switch for the selected Amplifier. The 
values are 1 minute, 2 minutes, 3 minutes, 5 minutes, 10 minutes, or 
15 minutes. While the Power Switch is enabled, a technician can press 
the Power Switch indicator on the chassis display and shut down the 
Amplifier. The Power Switch panel displays a Time Remaining field to 
count down the selected time period.

Internal DC Power Supply
Internal DC 
Power Supply

Displays detected operating voltage of the selected Amplifier. On initial 
entry to the Amplifier Diagnostics window, this panel is not populated 

with actual data. Select the refresh character  at the top left of this 
window to retrieve Power Supply values from the Amplifier. Use this 
same selection method to refresh the Power Supply panel. The range 
for this field is 40 to 60 V. Undervoltage indication on the panel is set to 
< 45 V, Normal Operating Range is 45 to 56 V, and Overvoltage is set 
to > 56  to 60 V. If Voltage exceeds 60 V, the Amplifier shuts down.
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Fields Description
Temperature
Temperature Displays the Amplifier Temperature value. On initial entry to the 

Amplifier Diagnostics window, this window is not populated with data. 

Select the refresh character  at the top left of this window to retrieve 
Temperature values from the Amplifier. Use this same selection method  
to refresh the Temperature panel. Temperatures are displayed on the 
Temperature scale, and are available as a numeric value on the right 
side of the Temperature scale. The range for this field is 0 to 120°C. 
Fan On/Off Temperature on the panel is set to 35°C, 75°C, 85°C and 
105°C, with 5 degrees of hysteresis. High Temperature indication is set 
for 77.5°C, Over Temp is set for 87.5°C, and the Amplifier shuts down if 
Temperature reaches 107.5°C.

Critical Path (Pilot Tone) Monitoring
Measured Level Displays the Measured Levels for the six audio channels on the 

selected Amplifier, and the Limit value that you can set. On initial entry 
to the Amplifier Diagnostics window, this window is not populated with 

data. Select the refresh character  at the top left of this window to 
retrieve Critical Path Measured Level values from the Amplifier. Use 
this same selection method to refresh the Critical Path Monitoring 
panel. A graphical display of the Critical Path Measured Level values 
is displayed on the six audio channel Measured Level scales, and a 
numeric value in a box to the right side of the Measured Level scales. 
The Critical Path Limit is displayed below the Measured Level scales, 
or by itself if you have not yet retrieve the Measured Level values. 
Make changes to the Limit value by increasing or decreasing the 
value in the dBFS box. The range for the Limit value is 0 to -50 dBFS. 
Changes made to the Limit in this window do not take effect until you 
click the Go button.
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Impedance Monitoring
Impedance 
Monitoring

Displays information related to monitoring Impedance on the Amplifier’s 
speaker circuit when the amplifier monitoring option in configuration 
is set to Impedance Monitoring, and compares the measured values 
against stored calibration values

Select the refresh character  at the top left of this window to retrieve 
Critical Path Measured Level values from the Amplifier. Use this same 
selection method to refresh the Critical Path Monitoring panel.

Allows you to automate Monitoring of Impedance level by setting 
the Lower Margin % and Upper Margin % to help calculate the 
measurement limits for the amplifier, and selecting the Auto Set button 
in the Impedance Monitoring window. In this case, a fault is raised on 
the System Controller if the measured impedance value falls outside 
the margin percentages that were based on the Measured Impedance 
level at the time of the Auto Set.

Allows you to manually set an Upper Limit and Lower Limit to the 
Measurement Level, where the system generates an Event if the 
measured impedance level does not fall within the two Limits. To 
manually monitor impedance on the Amplifier, set the Upper Limit and 
Lower Limit values on the Impedance Monitoring panel, and select the 
Manual Set button on the panel to send the Limits to the Amplifier. 

Limit values, and Measure Impedance values. The range is from 0 to 
4000 Ohms.

Click the Save Margin button after changing the Lower Margin and 
Upper Margin values to save them to the controller.
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Speaker
Speaker Status Displays information related to ISMT speaker status when the amplifier 

monitoring option in configuration is set to ISMT Spur Monitoring or 
ISMT Loop Monitoring, and provides status of ISMT speakers attached 
to the amplifier speaker loop.

Find All Click to initiate the amplifier search for ISMT speakers on its speaker 
run.

Test All Click to initiate self-test of ISMT speakers on the amplifier.
Auto Set All Click to set upper and lower impedance margins for all ISMT speakers 

on the amplifier speaker run.
Copy All to 
Config

Click to copy all ISMT speakers found on the amplifier to be inserted 
into local System Manager configuration.

Test
24V On Click to send 24 V on speaker wiring for this amplifier.
Tone On Click to have the ISMT card initiate a test tone signal on the amplifier 

speaker wiring.
Loop Break Test Click to have the ISMT card simulate a loop break on the amplifier 

speaker wiring.

Speakers
Speakers ISMT Speaker IDs found on this amplifier speaker run.
In Config Indicates the speaker has been added to System Manager 

configuration.
Found This is set for the speaker after executing a Find All test on the 

amplifier speaker run.
Passed Test This is set for the speaker after a Test All command is selected, a 

check mark indicates a pass state, and X indicates a fail.



103
SYSTEM MANAGER Description, Installation, and User Manual 
Federal Signal www.fedsig.com

Using Field Diagnostics

13.1.4 Field Diagnostics > Equipment > Input/Output Cards
Select one of the Input/Output Card groups from the Equipment list on the left side of the 
Field Diagnostics Equipment window. The Input/Output Card fields on the Diagnostics 
window are related to Basic Information, Card Settings, and Serial Communications. 
Information on this window is only displayed on this window for user information. 

NOTE: Any input or output card that is added to the equipment tree must have a 
channel created for the card prior to uploading the configuration to the controller or the 
configuration upload to the controller will fail.

To change this information, you must access the appropriate Configuration window.

Fields Description
Manufacturing Details
Serial Number Reported Serial Number for the specified Input/Output card.
Part Number Reported Part Number for the specified Input/Output card.
Board Build Date Reported Board Build Date for the specified Input/Output card.
Firmware Version Reported Firmware Version for the specified Input/Output card.
Firmware Commit Reported build number for the specified Input/Output card.
Basic Information
Name Displays user-defined Name for the specified Input/Output Card. 
Comments User-defined Comments for the specified Input/Output Card.
Serial Communications
Bus ID Displays the Bus ID for the Input/Output Card Group. The range is 1-4.
Node ID Displays the Node ID for the Input/Output Card Group. The range is 

1-63.
Timeout Period Displays number of seconds until communication times out. The range 

is 1.0 to 26.5 seconds in 0.1 second steps.
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13.1.5 Field Diagnostics > Equipment > Input Cards Channel
Select one of the Input Cards Channel from the Equipment list on the left side of the 
Field Diagnostics Equipment window. The Input Card Channel fields on the Diagnostics 
window are related to Basic Information, card Settings, and Visibility (related to system 
Event Log and System Activity). Information on this window is only displayed on this 
window for user information. 

To change this information, access the appropriate Configuration window.

Fields Description
Basic Information
Name User-defined Name for the specified Input Card Channel. 
Comments User-defined Comments for the specified Input Card Channel.
Settings
Sense Sense for the Input Card Channel defines the behavior of the system 

when the signal is detected. Sense can be Normally Open/NDE or 
Normally Closed/NE.

Mode Mode for the Input Card Channel defines the action supported by the 
system when the Button is clicked. Mode can be Direct, Toggled, or 
Latched. Holdoff Time and Minimum Active Time are only visible for 
Direct Mode.

Contact Type Contact Type can be Dry/Volt Free Contact or Wet/Energized Contact. 
Use this field with isolated Input Cards. It is not visible on the Monitored 
Input Card or Virtual Input Card configuration.

Holdoff Time Defines the amount of time that must pass before the input can be 
triggered after being cleared. The value can be set between 0 and 
1 hour in 1 second increments.

Minimum Active 
Time

Minimum Active Time indicates the Minimum Time an action remains 
active after being initiated. Minimum Active Time is only visible when 
Mode is Direct Mode. Minimum Active numerical information is only 
visible when the corresponding check box is enabled. Range is 0.1 
second to 1 hour in 0.1 second increments.
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Fields Description
Maximum Active 
Time

Maximum Active Time indicates the Maximum Time an action remains 
active after being initiated, if the activating signal is still active. 
Maximum Active numerical information is only visible when the 
corresponding check box is enabled. Range is 0.1 second to 1 hour in 
0.1 second increments.

Active on Failure User selectable state that enables the input channel to be left active if 
communications is lost to the Input Card Channel.

Visibility
Show STATE in 
Event Log

Visibility field that enables state reporting in the System Event Log.

Show STATE in 
System Activity

Visibility field that enables state reporting in the System Activity window.

13.1.6 Field Diagnostics > Equipment > Output Cards Channel
Select one of the Output Cards Channel from the Equipment list on the left side of the 
Field Diagnostics Equipment window. The Output Card Channel fields on the Diagnostics 
window are related to Basic Information, card Settings, and Visibility (related to system 
Event Log and System Activity). Information on this window is only displayed on this 
window for user information. 

To change this information, access the appropriate Configuration window.

Fields Description
Basic Information
Name User-defined Name for the specified Output Card Channel. 
Comment User-defined Comments for the specified Output Card Channel.
Settings
Sense Sense for the Output Card Channel defines the behavior of the system 

when the signal is detected. Sense can be Normally Open/NDE or 
Normally Closed/NE.

Active On Failure Check box that indicates whether the card should be active when 
failed.
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Fields Description
Active On Power-
Up / Reset

Check box that indicates whether the card should activate on power up 
or reset.

Visibility
Show STATE in 
Event Log

Visibility field that enables state reporting in the System Event Log.

Show STATE in 
System Activity

Visibility field that enables state reporting in the System Activity window.

13.1.7 Field Diagnostics > Equipment > Fan Monitoring Cards
Select one of the Fan Monitor Cards from the Equipment list on the left side of the 
Field Diagnostics Equipment window. The Fan Monitor Card fields on the Diagnostics 
window are related to Manufacturing Details, Current Temperature, Statistics, and Fans 
(including Override Automatic Fan Control). 

Fields Description
Manufacturing Details
Serial Number Reported Serial Number for the specified Fan Monitor card.
Part Number Reported Part Number for the specified Fan Monitor card.
Board Build Date Reported Board Build Date for the specified Fan Monitor card.
Firmware Version Reported Firmware Version for the specified Fan Monitor card.
Firmware Commit Reported build number for the specified Fan Monitor card.
Current Temperature
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Fields Description
Current 
Temperature

Displays the system temperature value. The System Controller card 
requests system data from the Fan Monitoring Card automatically, no 
need for a refresh button. Temperature is displayed on the temperature 
scale and are available as a numeric value on the right side of the 
temperature scale. Range for this field is -30 to 100°C. 
Default temperatures are:
•	 Fan on is set to 50°C
•	 Fan off is set to 40°C
•	 Overtemp is set to 70°C
•	 Undertemp is set to 10°C
All four fields are programmable on the Fan Monitoring Card 
Configuration window. 

Statistics
Operating Time Provides an indication of how long System Fans have been active 

since last system start or since you have clicked Reset Statistics. Time 
is displayed in hours and minutes.

Start/Stop Cycles Indicates how many times the Fans have transitioned between Stop 
and Start since last system start or since you have clicked Reset 
Statistics.

Reset Statistics Allows you to reset the two Statistics fields to zero: Operating Time and 
Start/Stop Cycles.

Fans
Fans Displays a check mark in the Running column if the Fans are operating 

and displays Fan speed in the RPM column.
Override 
Automatic Fan 
Control

Allows you to override the normal system control of the System Fans. 
You can select a time period to force the Fans to operate. The values 
are 15 seconds, 30 seconds, 60 seconds, 2 minutes, 3 minutes, or 
5 minutes. To start Fan operation, select the time period, and then click 
Force Fans On. You should see the Fan Status change to an operating 
status, while the Time Remaining field counts down to the selected 
time period. Fans automatically stop operating at completion of the 
time count down.
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13.1.8 Field Diagnostics > Equipment > Access Panel
Select one of the Access Panels from the Equipment list on the left side of the Field 
Diagnostics Equipment window. The Access Panel fields on the Diagnostics window 
are related to Basic Information and Slave Access Panel, and are not changeable on the 
Field Diagnostics window. 

To change this information, access the appropriate Configuration window.

Fields Description
Basic Information
Name User-defined Name for the specified Access Panel Button. 
Comment User-defined Comments for the specified Access Panel Button.
Location Read-only field that provides the system defined location for the 

Access Panel.
Slave Access Panel
This Panel is a 
Slave Panel

Checked if this Access Panel is going to be a slave panel to a Master 
Access Panel 

Master Panel ID Displays the ID number for the Master Access Panel. This field is only 
populated if This Panel is a Slave Panel is checked.
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13.1.9 Field Diagnostics > Equipment > Access Panel Button
Select one of the Access Panel Buttons from the Equipment list on the left side of 
the Field Diagnostics Equipment window. The Access Panel Button fields on the 
Diagnostics page are related to Basic Information, Settings, and Visibility, and are not 
changeable on the Field Diagnostics window. 

To change this information, access the appropriate Configuration page.

Fields Description
Basic Information
Name User-defined Name for the specified Access Panel Button. 
Comment User-defined Comments for the specified Access Panel Button.
Settings
Sense Defines the behavior of the system after the Button is clicked. Sense 

can be Normally Open/NDE or Normally Closed/NE
Mode Defines the action supported by the system when the Button is clicked. 

Mode can be Direct, Toggled, or Latched.
Holdoff Time Defines the amount of time that must pass before the input can be 

triggered after being cleared. The value can be set between 0 and 
1 hour in 1 second increments.

Active Time Active Time shows time this Button has been Active. Range is 0.1 
second to 1 hour in 0.1 second increments.

Active on Failure User selectable state that enables the Access Panel Button input to be 
left active if communications is lost to the Access Panel.

Visibility
Show State in 
Event Log

Visibility field that enables state reporting in the System Event Log.

System Activity Visibility field that enables state reporting in the System Activity 
window.
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13.2 Field Diagnostics > Audio Inputs
The Audio Inputs Field Diagnostics component allows you to evaluate performance of 
Audio Inputs sources in the System. Most of the Audio Inputs fields are not changeable 
on the Audio Inputs Field Diagnostics screen. 

To change this information, access the appropriate Configuration page.

Fields Description
Scope Relates to redundancy. Options include A Master, B Standby, 

Duplicated, or Shared.
Hardware Name Select one of the Audio Input sources in this column to display 

diagnostics fields for the source.
Description User-defined description for the selected Audio Input source.
Gain Trim
Gain Trim (dB) Sets the input gain for the input source. Change Gain Trim by moving 

the slider on the Gain Trim bar. On the right side of the Gain Trim slider 
is a numeric display of current Gain Trim. Gain Trim range is -30 to 
+6 db in steps of 6 dB.

Go Click this button to set Gain Trim for the selected Audio source.
Pilot Tone
Enable Pilot Tone 
Detection

Click check box to set the Pilot Tone Limit to half scale. Leaving it 
unchecked sets the Pilot Tone Limit to zero.

Measured Level Returns the system measured Pilot Tone Level in dBFS. Select 
the refresh symbol  to retrieved Measured Level. Range is 0 to 
-100 dBFS in steps of 1 dB.

Limit Sets Pilot Tone Limit. Limit defaults to zero when Enable Pilot Tone 
Detection is checked, and set to half scale when Enable Pilot Tone 
Detection is unchecked. When the Enable Pilot Tone Detection is set, 
set the Pilot Tone Limit by moving the slider on the Limit bar. 

Go Click this button to set Pilot Tone Limit for the selected Audio source.
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13.3 Field Diagnostics > Audio Outputs
The Audio Outputs Field Diagnostics component allows you to evaluate performance of 
Audio Output sources in the system. Most of the Audio Outputs fields are not changeable 
on the Audio Outputs Field Diagnostics window. 

To change this information, access the appropriate Configuration page.

Fields Description
Scope Options include A Master, B Standby, Duplicated, or Shared.
Name User-defined Name for the Audio Output.
Zone Assignment Indicates the target zone for the output.
Pilot Tone Level Indicates the current Pilot Tone Level for the selected output audio 

signal. Change the Pilot Tone Level by moving the slider on the Pilot 
Tone Level dBFS bar, or by using the left/right arrow buttons on to 
move the value up or down. A change to this field is automatically sent 
to the System Controller. The numeric value of the Pilot Tone Level 
dBFS is display to the right of the bar. Range is 0 to -100 dBFS in 
steps of 1 dB. Setting the level to -100 dBFS disables Pilot Tone for the 
selected output.
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14.0 Getting Service
If you are experiencing any difficulties, contact Technical Support at: 800-524-3021 or 
through e-mail at: techsupport@fedsig.com. For instruction manuals and information on 
related products, visit: http://www.fedsig.com/

2645 Federal Signal Drive
University Park, Illinois 60484-3167

www.fedsig.com

Technical Support	 800-524-3021
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